Use a Bond to Discharge Debts

last updated 9/7/2003

Disclaimer
The material in this information packet is for educational purposes only and not to be construed as legal advice about what you should or should not do.  The information herein is to assist you in performing your own due diligence before implementing any strategy.  By using this material, you are agreeing that no particular result is guaranteed or implied.
Some conventions used in this document:

Throughout this file you will see information in two different fonts and colors.  Instruction pages will use Arial (san serif/without curves) font and navy blue as the color (this page uses this font and color).  The information on the instruction pages will be educational in nature but most of the time there will be instructions to follow or tasks to perform on the instruction pages.  Document (bill of exchange, certificate of service, etc) pages use Times Roman (serif/with curves) font and in black ink.  You will customize the document pages and then do something with them such as mail or record them.  Instructions will generally not be mixed with the document pages but if it is necessary to mix them, the font and text color conventions will be followed.  So, if there are instructions imbedded in a document page, you will need to delete the instructions before printing the final version of the document page.

Discharge Debt:

The purpose of this file is to create documents (Bond, Statement of Account, etc.) that can be used to discharge debts.  A bond cannot be used to buy an item (car, house, stereo system, big screen TV, etc.).  A bond can only be used to discharge pre-existing debts.  At this point, we believe that some sort of “loan” would have to exist or credit used to purchase the item and then a bond can be used to discharge the “loan”.  We say “discharge” rather than “pay” a debt because since 1933 we have only had the ability to “discharge” a debt.  The basis of all “money” in circulation in America, since 1933, has been a Federal Reserve Note.  A note is a debt instrument, a promise to pay.  Common sense says that you cannot pay a debt with a debt (a Federal Reserve Note, or any other promise to pay).  The foundation of our ability to discharge a debt using a bond is House Joint Resolution 192 of June 5, 1993.  If you are not familiar with this legislation, you should study it thoroughly.

Situations in which bonds have been used:

Perhaps you are wondering if there are situations where bonds have been used successfully.  Below is a partial list of those we are aware have been successful:

· IRS – Bonds have been used to pay federal income taxes, penalties and interest.  We understand, if there is a lien or levy by the IRS, that the original bond should be sent to the Internal Revenue Service, Federal Payment Levy Program, P.O. Box 57, Bensalem, PA 19020.  You might want to download Publication 1450 from the IRS web site (http://www.irs.ustreas.gov/prod/cover.html).  It clearly states that you can have liens removed by using a bond.  Several weeks after issuing the bond, you can call the IRS office in Ogden, UT to check the balance on any year in question.  The phone number is 801-799-6958.

· State taxes

· Property taxes 

· Traffic tickets, fines and citations

· Stop foreclosures on homes

· Credit card debt

· Getting back property that has been seized by the government

· Mortgage loans

In theory, a bond can be used to discharge any debt that has been billed by any legal fiction, which includes corporations, governments, limited liability companies, limited liability partnerships, trusts, etc.

Situations where bonds should not be used:

Bonds cannot be used to discharge loans or debts between living souls.  If you borrow a cup of sugar from your neighbor, you owe your neighbor a cup of sugar.  Remember that it is the “money”, something with intrinsic value, that was replaced with the promissory notes (debt instruments).  Biblical law prohibits living souls from entering into “commerce”.  It is the straw man’s exemption account that enables the bond to be issued, because it is the straw man who has the “energy” to make the transaction because there is no “money”. 

We strongly advise you not to attempt to discharge an auto loan.  An auto loan is a secured debt with the auto being the collateral.  If you issue a bond on a car loan and stop making payments, the “creditor” may very well hire a company to reposses (steal) the car from you.  The police will generally not do anything to intervene is this situation, as they see it as a dispute over money, which is a matter for a civil court.

How “creditors” respond to bonds:

We are sure you are wondering how creditors typically respond to receiving a bond.  First, we should say that we don’t know of a single instance in which anyone has gone to prison for issuing a properly executed bond.  But we must also say that, in many cases, “creditors” are not going to like receiving your bond.

Before elaborating on this point, let’s explain why use the term “creditors”, in quotes.  We believe that we, as living souls, are ultimately the source of all credit.  This being the case, “We the People” are the ultimate creditors and those whom we have called “creditors” in the past are really just people or organizations to whom we issue some of our credit.  Throughout this document, we call these people/organizations either “creditors” or “claimants”.

In accounting terms, a credit is a minus and a debit is a plus.  So, a credit would decrease an entry and a debit would increase an entry.  By law, all “fictions” have double-entry accounting ledgers where, when one account is increased, another must decrease in order to balance.  From the lender’s perspective, a loan is an asset.  So, each payment you make decreases their loan account asset and increases their funds available asset.  From your perspective, if you owe a loan, you probably keep track of it with a single entry, starting with a beginning entry of a dollar amount of what you owe.  As you make payments you decrease the amount, rather than the double entry where you decrease the liability and increase your ownership in the asset.  Your bookkeeping practices likely do not comport with the accounting principles that are mandated of the corporations. 

So “credit”, in the generic sense is how large your borrowing ability is rather than the realization that it is actually a mirrored and backward entry of reality.  It is this reverse accounting that so often confuses people.  

When you issue a bond, it is ledgered twice:  to offset the debt by decreasing the straw man’s ledger and increasing the lender’s ledger – and the books balance.  Remember that you cannot “pay” a debt with a debt.  So, your only solution is to issue a promise to pay the debt, or use a bond, to order ledgering.

We’ve said that the “creditor”, in most cases, won’t like your bond.  This is because they are accustomed to receiving a lot of interest on the principal payments for alleged “loans” they made to us, a transaction in which they actually loaned us our own credit.  Said another way, they have pretended to “loan” us money, then ask us to pay back the principal with interest when, in fact, they loaned us nothing of substance and took no risk in the transaction.  When we use the bond to discharge our supposed debt to them, we cut off their supply of all the profits that they think they deserve.

At this stage in the use of bonds, it is hard to predict exactly how any individual “creditor” will respond.  So, you need to be prepared for the possibility that they will act as if you have never “paid” them.  If you are discharging credit card debt, they may close or cancel the account, turn your account over to a collection agency, and put negative information on your credit report.  None of this means that your bond was invalid, illegal or fraudulent.  It just means they don’t like it.  And you have solutions to handle that type of reaction.

Your first and most important decision will be to answer this question within yourself, “Did my bond really discharge the debt?”  When you can answer this question with a resounding, “Yes”,  then you will have taken a major step and can move forward.  If you cannot answer affirmatively, we’d suggest you take a step backward and do more research to gain a better understanding of how commerce really works.

Let’s use an example to illustrate this point.  Let’s say you owed someone $100 and that you sent them a $100 Federal Reserve Note (FRN) to discharge the debt.  But then they acted as if the debt was still owed.  In this case, was the debt discharged?  Assuming they received the “money”, then the answer should be yes!  The only question remaining in your mind should be:  Is the bond a good instrument?  If you can’t be comfortable that is good and valid, you should not be using bonds.

We are working on strategies to deal with “creditors” who act as if your bond is no good.  As we gain further experience in these areas, we will make additional information available.

“Creditors” who don’t accept/recognize bonds:

It is quite possible that the creditor will continue to send you presentments that reflect that the bond payment was never posted.  We view this as an attempt to recontract on an account that has already been settled.  Do not ignore any presentment you receive.  You must respond to whatever they send within three days (72-hour rule).

It is very important that you respond to any presentment the “creditor” sends you so that you can remain in honor.  The bond paid the “creditor” in full.  Any party who attempts to collect further money should be treated as a 3rd party (not a party to the original contract) debt collector.  On the face of any presentment they send you, in red, blue or any color other than black, write the following:

Accepted and returned for closure, discharge and settlement of this accounting.  See attached copy of Registered Bond # <rm#-bond-num>.  You are using my exemption.  Send me the voucher immediately.  Equality under the law is paramount and mandatory.  I am competent to handle my affairs.  If you think you are representing me in this matter, you and your heirs/assigns/agents are hereby declared to be incompetent and are fired.  Without prejudice and without recourse.

Date __________________ By ________________________

Here is an explanation of each phrase:

· “Accepted” – By accepting the presentment, you remove any controversy and remain in honor.  This also has the effect of making you the holder in due course of their presentment.  You are creating a contract and you can add your own conditions to it.  So, the rest of the text is the conditions that you are adding.

· “and returned for closure, discharge and settlement of this accounting” – You are saying you want to settle the matter.  You are ordering them to zero the balance on the account.

· “See attached copy of Registered Bond # <rm#-bond-num>” – You are reminding them that you have already discharged the debt with a bond.

· “You are using my exemption” – Your exemption is what is standing behind the bond and what makes the bond good.

· “Send me the voucher immediately” – If they want to argue or discuss the matter further, they will need to send a voucher.  The voucher would be a check for 10% of the value of the bond.  They won’t do this, but it is a way to “mess with them” if they want to “mess with you”.

· “Equality under the law is paramount and mandatory” – You are reminding them that whatever they demand of you, you can demand of them.

· “I am competent to handle my affairs” – They are assuming that you are not competent to handle your own affairs.  So you are stating that you are competent.

· “If you think you are representing me in this matter, you and your heirs/assigns/agents are hereby declared to be incompetent and are fired” – They may be presuming that they can represent you and make legal determinations on your behalf, so you are telling them that you are granting no such power to them.

· “Without prejudice” – This phrase comes form UCC 1-207 and means you are reserving all of your law rights.

· “without recourse” – This phrase comes from UCC 3-414(e) and 3-415(b) and means, if the recipient dishonors the “contract” (the presentment they sent you with your additions), then you, as the endorser, are not liable to “pay”.

· By signing your regular signature after “By”, you are signing as the secured party with a lien position (UCC-1) and a copyright on the straw man.

If the creditor continues to send you presentments, it can become quite a nuisance.  So, we’d suggest you send the creditor a Conditional Acceptance and Negative Averment or Affidavit.  If the creditor does not respond appropriately, you will need to begin a Notarial Protest.  These two steps are bundled in a Notarial Protest product.  Ask the person who told you about the bond information and they can give you further information.  The Notarial Protest will result in a Certificate of Non-Response and Dishonor against the creditor.  The Certificate of Dishonor can be used to help clear any negative information the creditor puts on your credit report.  We also can refer you to an economical credit repair service to assist you.

Note:  Depending on what you are issuing the bond for, some of the wording may need to be changed.  As an example, if the bond was used to settle the account with a credit card company, you would not want a “deed”.

Pre-requisites for issuing bonds:

Before using a Bond, execute and record your

1) Copyright

2) Declaration by Affidavit in Support of the Bond
3) UCC-1 to give notice of your interest in any property you are using the bond for, so that you can report a felony if it is seized

Conventions used in this document:

Throughout the rest of this file, the beginning of each step will start with instructions which will be proceeded with a letter for the step.  The step will be identified with large bold red text giving the step name and letter.

a. Gather your materials

Obtain the following office supplies:

· 9 x 12” envelopes to mail the bonds

· 10 x 13” envelopes to mail the bonds

· You may also wish to purchase self-inking red stamps that say “original” and “copy”

· Scotch tape, staples and stapler

For each bond, obtain the following materials by ordering them online or going to the Post Office: 

· 1 – Registered Label PS Form 200 (red sticker) – used for the claimant

· 1 – Receipt for Registered Mail PS Form 3806 – used for the claimant

· 3 – PS Form 3800, (Certified Mail Receipt) – two for the Secretary of the Treasury and one for the sheriff of your county.

· 4 – PS Form 3811 (Domestic Return Receipt, green card)
· Also obtain a supply of flat rate priority mail envelopes both letter and half-size, and USPS 228 Priority Labels

You will use each of the supplies listed above for each bond you issue, and it’s always a good idea to have extras in case you make a mistake, so obtain plenty of each item.

b. Replace tags with your data – one time

The bond documents contain a number of variables (called “tags”) that act as place holders for your personal data.  The table below shows a list of all of these tags.  The first column explains what the data should be, the second is the strings that will be replaced (the tag) and the last column is a sample of what the data might look like in place of the tag.  You will be replacing all of the tags for the entire redemption process as you follow the steps below.

Before you begin your customizing work, save a copy of this file now under a different file name.  Use the “Save as…” option under the “File” menu; i.e., you might insert your last name and the date when the file was created somewhere in the file name, e.g. Smith-Bond-template-2003-07-21.doc.  This version of the file can be used as a template for future bonds that you will issue.

You will use the “Replace…” facility in MS Word to search for and replace each of the strings in the “Replacement String” column shown below.  The “Replace…” menu item can be found under the “Edit” menu.  When you select “Replace…” a dialog box will open that contains a line labeled “Find what:” where you will enter the string you want to replace.  The dialog box also contains a “Replace with:” line where you will enter the correct data. 

For example, if you want to replace the “<ssn>” tag, you would enter “<ssn>” in the “Find what:” line and type your SSN on the “Replace with:” line.  Then, you would click the “Replace All” button.  Repeat this process for each tag in the list.

To make sure that you have not missed any tags, scroll to the top of this file and perform a search operation for “<”.  The “Find” menu item is under the “Edit” menu.  If you aren’t able to locate any tags, then you have successfully replaced all tags.

Once this is done, save the file again under the new name to make sure you don’t lose all your work.

	Description
	Replacement string
	Sample data

	True Name - your current full legal name with upper & lower case letters
	<true-name>
	John Quincy Public

	Your mail address 
	<mail-street>

<mail-city-st-zip>
	100 Maple Ave.

Irving, Texas [75000]

	The county where you reside
	<re-county>
	Dallas

	The state where you reside
	<res-state>
	Texas

	Your straw man’s Social Security number
	<ssn>
	123-45-6789

	Your gender, “man” or “woman”
	<gender>
	Man

	The name and address of the sheriff of your county.  (Optional – only if you want to send a copy of the bond to the sheriff.)
	<sheriff-name>

<sheriff-name>

<sheriff-city-st-zip>
	Matt Dillon

1001 Jailhouse Row

Dallas, Texas [75000]


c. Replace tags with your data – for each bond

In this step, begin with the file that you created in the previous editing step.  For example, if, in the last step you created a file named Smith-Bond-template-2003-07-21.doc, then this would be the file you should now open.
The table below is a list of tags that must be changed for each Bond you issue.  Use the same procedure as the instructions above to replace these tags. 

To make sure that you have not missed any tags, scroll to the top of this file and perform a search operation for “<” using the “Find” menu item is under the “Edit” menu.  If you aren’t able to locate any tags, then you have successfully replaced all tags.

Once you replace all these tags, save a copy of the file under another new name.  The name of the file could reflect the name of the “creditor” to whom you are issuing the Bond and the date your are issuing the Bond.  For example, if you were issuing a Bond to Bank Of America, you could name Bond-BankOfAmerica-2003-07-01.doc.

	Description
	Replacement string
	Sample data

	The name on your account with the “creditor”, usually in upper case
	<account-name>
	JOHN Q PUBLIC

	The account number you have with the claimant
	<account-number>
	9876 5432 1098 7654

	The number of the bond, same number as registered mail certificate used to mail the bond to the claimant
	<rm#-bond-num>
	RR 111 222 333 US

	The date you are going to issue/mail the bond
	<bond-date>
	June 5, 2003

	The date the presentment (bill) from the claimaint is due.
	<due-date>
	June 15, 2003

	The date on the presentment, charging instrument, or invoice (date it was issued by the claimant) or the invoice number
	<invoice-date-num>
	June 1, 2003

	The dollar amount of debt you are discharging
	<discharge-amt>
	9,526.00

	The name of the party making a claim against you.  Good idea to make it all capital letters
	<claimant-name>
	ABC CREDIT CARD SERVICES

	The address of the party making a claim against you.  Good idea to make it all capital letters
	<claimant-street>

<claimant-city-st-zip>
	1500 EAST AVE

SIMI VALLEY, CA 93065

	The name of the friend who will mail the bond packets
	<friend-name>
	Mary Jones

	The address of the friend who will mail the bond packets
	<friend-city-st-zip>
	c/o 101 Elm Ave.

Irving, Texas [75000]

	Certified mail # used to send copy of Bond for you to the Secretary of theTreasury. 
	<cm#-sec-treas>
	7003 0500 0000 8928 4040

	Certified mail # used by claimant to send the Bond to the Secretary of the Treasury.
	<cm#-sec-treas2>
	7003 0500 0000 8928 4047

	Certified mail # used to send copy of Bond to your County Sheriff
	<cm#-sheriff>
	7003 0500 0000 8928 4053


d. Prepare the original bond

Print a single copy of the original bond shown on the next page.

This file contains many section breaks.  Your version of MS Word may not support printing a page range when the document contains page breaks.  If this is the case, when you attempt to print a page range, the entire document will be printed.  The way around this is to put the cursor on a specific page and print just the “current page” which is one of the options in the dialog that is displayed when you select the “Print” menu item in the “File” menu.

Now, sign the bond in blue ink next to “BY” and as “Owner”.  Fill in the date you printed the bond in two places.  Sign the bond in two places using your normal signature.  After the word ‘seal’, place your thumb print (using ink of any color other than black) and sign your initials on the thumb print (half in and half out) in blue ink.  This is the original bond and it will be mailed to the claimant.

BOND

Registered Mail <rm#-bond-num> 

Registered Promise to Pay to the Order of:

AGENT

<claimant-name>

<claimant-street>

<claimant-city-st-zip>

EQUALITY UNDER THE LAW IS PARAMOUNT AND MANDATORY BY LAW.

I, <true-name>, a Titled Sovereign, do hereby declare:

There appearing no bond, contract or title of record entered by claimant to initiate the matter alleged by <claimant-name> regarding claim number <account-number>; 

I, issue this bond to discharge all debt in the matter of claim number <account-number> dischargeable to <claimant-name> as mandated by public policy through the Bureau of Public Debt.  In that no lawful money of account exists in circulation and in consideration thereof, I have suffered dishonor by <claimant-name> regarding the matter of alleged creditor’s claim number <account-number>.

I, <true-name>, principal, as surety, am held and bound to pay <claimant-name> the sum of $<discharge-amt>, unless the alleged debtor <account-name>© shall satisfy any debt which may be recovered against it by the alleged creditor <claimant-name> for the attachment of alleged debtor <account-name>© for the sum certain $<discharge-amt>, returnable to <claimant-name>, <claimant-street>, <claimant-city-st-zip> on <due-date>.  I, <true-name>, underwrite with my private exemption any and all obligations of performance/loss/costs sustained by <claimant-name>.

Done this ___ day of ___________, 200__ in the county of <res-county>, <res-sate> by me <true-name>, a Titled Sovereign, owner, principal, surety, the <gender>.

debtor’s signature: <account-name>   copyrighted fiction

By: __________________________________________

<true-name>
ORDER

Negotiate this discharge item through the back office for settlement via the pass through account at the treasury window under public policy for discharge of debts in accordance HJR 192 June 5, 1933; 73rd Congress, 1st Session and all associated policies.  Charge exempt account number <ssn>.

This ____ day of _____________, 200__.
Owner _______________________________


seal:

Attachment(s):
Acceptance (Presentment from AGENT),


Statement of Account
e. Prepare the bond copies

Print three copies of the original bond shown on the next page.

This file contains many section breaks.  Your version of MS Word may not support printing a page range when the document contains page breaks.  If this is the case when you attempt to print a page range, the entire document will be printed.  One way to avoid this problem is to put the cursor on a specific page and the print just the “current page” which is one of the options in the dialog that is displayed when you select the “Print” menu item in the “File” menu.

Now, type in the date you printed the bond in two places.  On these copies write in the date in blue ink.  DO NOT SIGN THEM!  You will mail these bond “copies” to the Secretary of the Treasury, the Sheriff and keep one for your own records.  

BOND

Registered Mail  <rm#-bond-num>  


Registered Promise to Pay to the Order of:

AGENTS

<claimant-name>

<claimant-street>

<claimant-city-st-zip>

EQUALITY UNDER THE LAW IS PARAMOUNT AND MANDATORY BY LAW.

I, <true-name>, a Titled Sovereign do hereby declare:

There appearing no bond, contract or title of record entered by claimant to initiate the matter alleged by <claimant-name> regarding claim number <account-number>; 

I, issue this bond to discharge all debt in the matter of claim number <account-number> dischargeable to <claimant-name> as mandated by public policy through the Bureau of Public Debt.  In that no lawful money of account exists in circulation and in consideration thereof, I have suffered dishonor by <claimant-name> regarding the matter of alleged creditor’s claim number <account-number>;

I, <true-name>, principal, as surety, am held and bound to pay <claimant-name> the sum of $<discharge-amt>, unless the alleged debtor <account-name>© shall satisfy any debt which may be recovered against it by the alleged creditor <claimant-name> for the attachment of alleged debtor <account-name>© for the sum certain $<discharge-amt>, returnable to <claimant-name>, <claimant-street>, <claimant-city-st-zip> and <due-date>.  I, <true-name>, underwrite with my private exemption any and all obligations of performance/loss/costs sustained by <claimant-name>.

Done this ___ day of ___________, 200__ in the county of <res-county>, <res-sate> by me <true-name>, a Titled Sovereign, owner, principal, surety, the <gender>.

debtor’s signature: <account-name>   copyrighted fiction


By: _______________________________________

<true-name>
ORDER

Negotiate this discharge item through the back office for settlement via the pass through account at the treasury window under public policy for discharge of debts in accordance HJR 192 June 5, 1933; 73rd Congress, 1st Session and all associated policies.  Charge exempt account number <ssn>.


This ____ day of _____________, 200__.
Owner _______________________________


seal:

Attachment(s): Acceptance (Presentment from AGENT)
f. Customize & Print the Statement of Account

The next page contains a Statement of Account.  You will make the following changes to the Statement of Account.

· Replace the tag that says “<date 14 days current or mail date>” with a date that is 14 days after the day the bond is going to be mailed.  Do not count Sundays or holidays.  Check with the person who is complete the Certificate of Mailing for you to ensure their availability on the day you choose.  Remove the yellow highlighting once you have replaced the string.

· Replace the tag that says “<your state statute that corresponds to UCC 9-201>” with the parallel statute in your state.
Check the internet to look up your state equivalent for UCC 9-201.  The naming conventions of most states correspond with the UCC; i.e., the Arizona equivalent is 47-9201.  http://www.law.cornell.edu/uniform/ucc.html, may have a link to the UCC statutes for your state.  The reason you want to list your state statute is because there is really no such thing as UCC 9-201 or any other section reference.  The UCC is implemented into the statutes of each state.  In order for a reference to be legally valid, you have to include the statute in your state. Remove the yellow highlighting once you have replaced the string.

Print two copies of the Statement of Account once the modifications have been completed.

This file contains many section breaks.  Your version of MS Word may not support printing a page range when the document contains page breaks.  If this is the case, when you attempt to print a page range, the entire document will be printed.  The way around this is to put the cursor on a specific page and print just the “current page” which is one of the options in the dialog that is displayed when you select the “Print…” menu item in the “File” menu.

Sign one copy of the Statement of Account in blue ink using your normal signature.  This will be the original copy and it will be mailed to the claimant.  On the signature line of the other copy, you can print COPY, which you will keep for your records.

<true–name>

c/o <mail-street>

<mail-city-st-zip>

AGENT, <claimant-name>
<claimant-street>

<claimant-city-st-zip>

Re: 
Statement of Account


Account # <account-number>/<account-name>©


Registered Bond# <rm#-bond-num>
Statement of Account

<bond-date>
Balance of Charges on <invoice-date-num>
$<discharg-amt>>

Discharge <bond-date> with Registered Bond #<rm#-bond-num>
- <discharge-amt>
Ending Balance of Charges:
$ 0.00

The balance shown above reflects my good faith Statement of Account for the account indicated above.  The Account Representative or his designee may correct or approve the statement.  If you determine the balance is different than as shown above, your documented correction must be returned to me within two weeks, no later than <date 14 days current or mail date>.  Pursuant to <your state statute that corresponds to UCC 9-210>
 and UCC 9-210, failure to correct and return this Statement of Account with supporting documentation of indebtedness within two weeks, constitutes your agreement with this accounting, after which you, and your agents, assigns and successors may only make a claim up to the amount this statement shows as a balance.

By: 

<true-name>, a <gender>, holder in due course, principal, surety, owner

g. Certificate of Service to Claimant

The next two pages contain two versions of the Certificate of Service for the package you will mail to the claimant.  The first version should already contain your friend’s name and address.  You will keep this first version that contains your friend’s name, address and signature for your records.  

The second version (with blanks for your friend’s information) is to be included in the packet to the claimant.  The second version has blanks where you friend’s name and address would be printed.  In this way, you notify the claimant that someone mailed it for you, but you are not revealing who that person is.

If you do not know which friend will mail the packet to the claimant as you are preparing the documents, you can print two copies of the second version and no copies of the first version. 

If, on the other hand, you do know which friend will mail the packet for you, then print one copy of each version of the document.

This file contains many section breaks.  Your version of MS Word may not support printing a page range when the document contains page breaks.  If this is the case, when you attempt to print a page range, the entire document will be printed.  The way around this is to put the cursor on a specific page and print just the “current page” which is one of the options in the dialog that is displayed when you select the “Print” menu item in the “File” menu.

CERTIFICATE OF SERVICE

On _______________________, on behalf of <true-name>, I mailed to:

AGENTS, <claimant-name>
<claimant-street>

<claimant-city-st-zip>

the papers identified as:

1. Original Registered Bond # <rm#-bond-num>

2. Statement of Account

3. Presentment from AGENT <invoice-date-num>

4. Copyright

5. Envelope to mail bond to Secretary of the Treasury

6. Copy of Certificate of Service

by mailing them in a postage pre-paid envelope, addressed to the recipient named above, bearing Registered Mail # <rm#-bond-num> and obtaining a receipt from the Post Office clerk.

My mailing location is:

<friend-name>

<friend-street>

<friend-city-st-zip

I am over the age of 18 and not a party to the transaction regarding the papers I mailed.

Dated _______________________

Printed Name
Signature

CERTIFICATE OF SERVICE

On _______________________, on behalf of <true-name>, I mailed to:

AGENT, <claimant-name>
<claimant-street>

<claimant-city-st-zip>

the papers identified as:

1. Original Registered Bond # <rm#-bond-num>

2. Statement of Account

3. Presentment from AGENT <invoice-date-num>

4. Copyright

5. Envelope to mail bond to Secretary of the Treasury

6. Copy of Certificate of Service

by mailing them in a postage pre-paid envelope, addressed to the recipient named above, bearing Registered Mail # <rm#-bond-num> and obtaining a receipt from the Post Office clerk.

My mailing location is:

I am over the age of 18 and not a party to the transaction regarding the papers I mailed.

Dated _______________________

Printed Name
Signature

h. Certificate of Service to Secretary of the Treasury

The next two pages contain two versions of the Certificate of Service for the package you will mail to the Secretary of the Treasury.  The first version should already contain your friend’s name and address.  After your friend mails the document packets and signs and dates the first version, you will keep it for your records. 

The second version (with blanks for your friend’s information) is to be included in your packet that you are mailing to the Secretary.  The second version has blanks where your friend’s name and address would be printed.  In this way, you notify the claimant that someone mailed it for you, but you are not revealing who that person is.

If you do not know which friend will mail the packet to the Secretary as you are preparing the documents, you can print two copies of the second version and no copies of the first version.  

If, on the other hand, you do know which friend will mail the packet for you, then print one copy of each version of the document.

This file contains many section breaks.  Your version of MS Word may not support printing a page range when the document contains page breaks.  If this is the case, when you attempt to print a page range, the entire document will be printed.  The way around this is to put the cursor on a specific page and print just the “current page” which is one of the options in the dialog that is displayed when you select the “Print” menu item in the “File” menu.

CERTIFICATE OF SERVICE

On _________________________, on behalf of <true-name>, I mailed to:

John Snow, Secretary of the Treasury
Department of the Treasury
1500 Pennsylvania Ave. NW

Washington, D.C. 20220
the papers identified as:

1. Copy of Registered Bond # <rm#-bond-num>

2. Presentment from AGENT <invoice-date-num>

3. Copy of Certificate of Service

by mailing them in a postage pre-paid envelope, addressed to the recipient named above, bearing Certified Mail # <cm#-sec-treas>, and obtaining a receipt from the Post Office clerk.

My mailing location is:

<friend-name>

<friend-street>

<friend-city-st-zip

I am over the age of 18 and not a party to the transaction regarding the papers I mailed.

Dated _______________________

Printed Name
Signature

CERTIFICATE OF SERVICE

On _________________________, on behalf of <true-name>, I mailed to:

John Snow, Secretary of the Treasury
Department of the Treasury
1500 Pennsylvania Ave. NW

Washington, D.C. 20220
the papers identified as:

1. Copy of Registered Bond # <rm#-bond-num>

2. Presentment from AGENT <invoice-date-num>

3. Copy of Certificate of Service

by mailing them in a postage pre-paid envelope, addressed to the recipient named above, bearing Certified Mail # <cm#-sec-treas> and obtaining a receipt from the Post Office clerk.

My mailing location is:

I am over the age of 18 and not a party to the transaction regarding the papers I mailed.

Dated _______________________

Printed Name
Signature

i. Certificate of Service to Sheriff

The next two pages contain two copies of the Certificate of Service for the sheriff of your county.  Sending a copy of the bond to the sherriff of your county is suggested but it is not required.  If you are concerned that the claimant may try to have the sheriff serve some papers on you regarding the debt you are dishcharging, you should print copies of the next two certificates of service, otherwise you can skip this step.

If you decide to print these certificates of service, print one copy of each version.  The first version is for your friend to sign and return to you.  The second version is to be included with the packet that will be mailed to the sheriff.

The next two pages contain two versions of the Certificate of Service for the claimant.  The first version should already contain your friend’s name and address.  The second version has blanks where your friend’s name and address would go.  You will want to retain the copy for your records that contains your friend’s name, address and signature.  The second version (with the blanks for your friend’s information) is to send to the claimant.  In this way, you notify the claimant that someone mailed it for you, but you are not revealing who that person is.

If you do not know which friend you will mail the packet to the claimant for you, as you are preparing the documents, you can print two copies of the second version and no coplies of the first version.

If, on the other hand, you do know which friend will mail the packet for you, then print one copy of each version of the document.

This file contains many section breaks.  Your version of MS Word may not support printing a page range when the document contains page breaks.  If this is the case, when you attempt to print a page range, the entire document will be printed.  The way around this is to put the cursor on a specific page and print just the “current page” which is one of the options in the dialog that is displayed when you select the “Print” menu item in the “File” menu.

CERTIFICATE OF SERVICE

On _________________________, on behalf of <true-name>, I mailed to:

<sheriff-name>

<sheriff-street>

<sheriff-city-st-zip>

the papers identified as:

1. Copy of Registered Bond # <rm#-bond-num>

2. Presentment from AGENT <invoice-date-num>

3. Copy of Certificate of Service

by mailing them in a postage pre-paid envelope, addressed to the recipient named above, bearing Certified Mail # <cm#-sheriff> and obtaining a receipt from the Post Office clerk.

My mailing location is:

<friend-name>

<friend-street>

<friend-city-st-zip

I am over the age of 18 and not a party to the transaction regarding the papers I mailed.

Dated _______________________

Printed Name
Signature

CERTIFICATE OF SERVICE

On _________________________, on behalf of <true-name>, I mailed to:

<sheriff-name>

<sheriff-street>

<sheriff-city-st-zip>

the papers identified as:

1. Copy of Registered Bond # <rm#-bond-num>

2. Presentment from AGENT <invoice-date-num>

3. Copy of Certificate of Service

by mailing them in a postage pre-paid envelope, addressed to the recipient named above, bearing Certified Mail # <cm#-sheriff> and obtaining a receipt from the Post Office clerk.

My mailing location is:

I am over the age of 18 and not a party to the transaction regarding the papers I mailed.

Dated _______________________

Printed Name
Signature

j. Print mail labels

The next page contains sample mailing labels to aid you mailing the packets.  You do not need to use these, but they are provided for your convenience.

The labels are in a table ready to print on Avery standard 5160 labels (30 per page, 1 x 2 5/8”).

Print one copy of the labels page.  Be sure to load the label forms into your printer.

This file contains many section breaks.  Your version of MS Word may not support printing a page range when the document contains page breaks.  If this is the case, when you attempt to print a page range, the entire document will be printed.  The way around this is to put the cursor on a specific page and print just the “current page” which is one of the options in the dialog that is displayed when you select the “Print…” menu item in the “File” menu.
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k. Assemble packets and mail 

Follow the steps below to assemble the packets for mailing and mail the packets:

1. Stamp or write diagonally across the face of all of claimant’s original presentments (bill, order, statement, etc) in Red, Blue, or any other color than Black the text below.  The Bond # is the Registered Label Number.

ACCEPTED FOR VALUE AND RETURNED 
IN EXCHANGE FOR DISCHARGE, CLOSURE, 
AND SETTLEMENT BY ATTACHED 
REGISTERED BOND #_________________
Date_________ By___________________________
2. Sign and date the original presentment “accepted for value” stamp you printed on it as shown in item 1 above.

3. Make three copies of the Presentment from the claimant and immediately stamp them “COPY” (you must return their original - you must only have one ORIGINAL Bond, otherwise it is fraud)  One is for your file.

4. Make one copy of the Copyright (from process B1) for the main Creditor and stamp it “COPY”.

5. Prepare envelope #1 to the Creditor. 

· Use a 10 x 13” envelope.  Do NOT put anything within one inch of any of the envelope edges.

· Affix the address label to the claimant near the center of the envelope, leaving space for the green postcard either next to the label or below it, at least one inch from all edges of the envelope.  If you are using a priority mail envelope, you can put the postcard on the back side of the envelope.

· Affix your return address label in the upper left corner at least one inch from both edges 

· Fill out PS Form 3806 (Receipt for Registered Mail) by hand with your address and the claimant’s address.  Do NOT write in the registered number on the receipt.  The Post Office will print the number on the receipt.

· Fill out PS Form 3811 (green card) 

· Box 1, print or affix the claimant address label

· Box 2, write the red registered mail sticker number in, scotch tape over it.

· Box 3, check the “Registered” box

· Print or write your return address label on the reverse “Sender” side. 

· Affix the PS 3811 to the front of the envelope and then scotch tape the adhesive sides to ensure it won’t be torn off in the sorting machine

· Affix the red registered mail sticker (# <rm#-bond-num>) to the middle of the envelope just above the creditor’s address label.

· DO NOT seal envelope #1.

· Paperclip the PS Forms 3806 to the envelope for the claimant.

6. Prepare envelope #2 for the Secretary of the Treasury. 

· Use a 9 x 12” envelope.  

· Print or affix an address label to the Secretary of the Treasury near the center of the envelope, leaving space for the green postcard either next to the label or below it.  If you are using a priority mail envelope, you can put the postcard on the back side of the envelope.

· Print or affix the claimant’s return address label in the upper left corner 

· Fill out PS Form 3800 (Certified Mail Receipt) by hand with the claimant’s return address and the address of the Secretary.  

· Fill out PS Form 3811 (green card) 

· Box 1, print or affix the Secretary address label

· Print or write your return address label on the reverse “Sender” side. 

· Box 2, write in the certified label number.  Peel off the certified number sticker and affix it over your handwritten number and scotch tape over it.

· Box 3, check the “Certified” box

· Affix the PS 3811 to the front of the envelope and then scotch tape the adhesive sides to ensure it won’t be torn off in the sorting machine

· Affix the PS 3800 Receipt to the top of the address immediately to the right of the claimant’s return address.

· DO NOT seal the envelope.  Envelope #2 will go inside envelope #1 to the claimant.  This envelope is so the claimant will mail the original bond to the Secretary of the Treasury to redeem it and you will get back the postcard so you know they mailed it.

· Staple the following items together:

· original bond, 

· original “Accepted for Value” presentment from the claimant.  

· Staple the following items together:

· original Statement of Account

· copy of the Copyright affidavit

· copy (without your friend’s name on it) of the Certificate of Service for the claimant.

· Place the two sets of stapled documents from above and envelope #2 inside envelope #1.  DO NOT seal envelope #1.

7. Prepare envelope #3 for you to send the notice to the Secretary of the Treasury.  

· Use a 9 x 12” envelope.  

· Print or affix an address label to the Secretary of the Treasury near the center of the envelope, leaving space for the green postcard either next to the label or below it.  If you are using a priority mail envelope, you can put the postcard on the back side of the envelope.

· Affix your return address label in the upper left corner 

· Fill out PS Form 3800 (Certified Mail Receipt) by hand with your  return address and the address of the Secretary.  

· Fill out PS Form 3811 (green card) 

· Box 1, print or affix the Secretary address label

· Print or write your return address label on the reverse “Sender” side. 

· Box 2, write in the certified label number.  Peel off the certified number sticker and affix it over your handwritten number and scotch tape over it.

· Box 3, check the “Certified” box

· Affix the PS 3811 to the front of the envelope and then scotch tape the adhesive sides to ensure it won’t be torn off in the sorting machine

· Affix the PS 3800 Receipt to the top of the address immediately to the right of your return address.

· Staple the following items together: 

· copy of the bond

· copy of the “Accepted for value” presentment from the claimant

· blank copy (without your friend’s name on it) of the Certificate of Service for the Secretary of the Treasury.  

· Place the stapled pages inside envelope #3.  DO NOT seal envelope #3.

8. Prepare envelope #4 for the Sheriff.

· Use a 9 x 12” envelope.  

· Print or affix an address label to the Sheriff near the center of the envelope, leaving space for the green postcard either next to the label or below it.  If you are using a priority mail envelope, you can put the postcard on the back side of the envelope.

· Affix your return address label in the upper left corner 

· Fill out PS Form 3800 (Certified Mail Receipt) by hand with your return address and the address of the Sheriff.  

· Fill out PS Form 3811 (green card) 

· Box 1, print or affix the Sheriff address label

· Print or write your return address label on the reverse “Sender” side. 

· Box 2, write in the certified label number.  Peel off the certified number sticker and affix it over your handwritten number and scotch tape over it.

· Box 3, check the “Certified” box

· Affix the PS 3811 to the front of the envelope and then scotch tape the adhesive sides to ensure it won’t be torn off in the sorting machine

· Affix the PS 3800 Receipt to the top of the address immediately to the right of your return address.

· Staple the following items together: 

· copy of the bond

· copy of the “Accepted for value” presentment from the claimant

· blank copy (without your friend’s name on it) of the Certificate of Service for the Secretary of the Treasury.  

· Place the stapled pages inside envelope #4.  DO NOT seal envelope #4

9. For your own records, staple the follow items together:

· copy of the bond

· copy of the “Accepted for value” presentment form the claimant

· copy of the Statement of Account. 

· When your friend gives you back the receipts, you will tape each one to a separate piece of 8.5x11 paper and then add the postcard to each page with its matching receipt.  You will keep the signed certificates of mailing from your friend.

10. Give the three packets that you have prepared (envelope 1, 3 & 4 with their contents) to a friend to mail.  Arrange with your friend how you will pay for the postage.  After mailing the three packets, your friend will fill out each of the three Certificates of Service (the version with your friend’s name and address, one for each of the following:  the claimant, the Secretary of the Treasury, the sheriff).

11. After your friend mails the packets for you, your friend will give the following materials to you so you can add it to your packet of material for issuing this bond: 

· 2 PS Form 3800, one to the Secretary and one to the Sheriff

· 1 PS 3806 Registered Mail receipt to the claimant

· 3 Certificates of Service, one for each of the above, signed by your friend.

12. After the 3 PS Form 3811 (green postcards) come back to you, tape them to the appropriate page which already should have taped to it the corresponding postal receipts.
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� Use of copyrighted codes and statutes within this document is only to notice the reader and all who would process this document that such references are not intended, nor shall it be construed, to mean that the Secured Party confers, submits to, or has entered into any jurisdiction alluded to thereby.






